Disclaimer

Information in this document is subject to change without notice and does not represent a commitment on the part of Software Bisque. The software and/or databases described in this document are furnished under a license agreement or nondisclosure agreement. They may be used or copied only in accordance with the terms of the agreement (www.bisque.com/eula). It is against the law to copy the software on any medium except as specifically allowed in the license or nondisclosure agreement. The purchaser may make one copy of the software for backup purposes. No part of this manual and/or databases may be reproduced or transmitted in any form or by any means, electronic or mechanical, including (but not limited to) photocopying, recording, or information storage and retrieval systems, for any purpose other than the purchaser's personal use, without the express written permission of Software Bisque.

Sky Charts created with TheSkyX First Light Edition are for personal use only. They may not be published in any form without express written permission of Software Bisque, Inc.

Telescope images) and are reproduced with permission. Photographs from the Anglo Australian Observatory telescopes are by David Malin.

The photograph of the Milky Way is licensed from Digital Sky LLC.

*TheSkyX* copyright 2010 Software Bisque, Inc. All rights reserved.

*TheSkyX First Light Edition* is a trademark of Software Bisque, Inc.

Winter Star Party panorama photographs courtesy Art Mullis.

Mac and the Mac logo are trademarks of Apple Computer, Inc., registered in the U.S. and other countries.

All other product names are trademarks of their respective owners and are used solely for identification.

Written by Andre Bormanis

Revised: March, 2010
# Table of Contents

**Welcome to TheSkyX First Light Edition!** .......... 7

- Getting Started ................................................................. 8
  - Updating Your Computer’s Video Driver .......................... 9
  - Installing TheSkyX First Light Edition ............................ 11
  - Removing TheSkyX First Light Edition ............................ 13
- Having a Look Around TheSkyX ............................................. 14
  - Entering Your Location .................................................. 14
- Tours ......................................................................................... 15
- Photos from the Deep Sky ........................................................ 16
  - Viewing Astronomical Photos ........................................... 16
- Your Sky Tonight ..................................................................... 17
- What’s Up, Doc? ................................................................. 17
- The Calendar ............................................................................. 18
- Exploring the Sky Chart ........................................................... 19
  - Changing the Date and Time ............................................ 19
  - Direction – The Look Commands .................................... 20
  - Field of View ...................................................................... 21
  - Setting the Field of View .................................................. 22
- Stellar Cartography .................................................................. 23
- Cosmic Coordinates ................................................................. 24
- Stars and Constellations ............................................................ 26
  - Star Names ......................................................................... 26
  - Bright Stars and Dim Stars ............................................. 27
  - Setting the Magnitude Limit ............................................. 28
  - Other Chart Elements ........................................................... 29
  - A Star to Guide You: Polaris ............................................. 29
  - Double Stars ..................................................................... 30
  - Finding Mizar .................................................................... 31
  - Variable Stars .................................................................... 31
- Classifying Stars: The Stellar Zoo ............................................ 32
  - Giants and Dwarfs .............................................................. 33
  - More About Constellations ................................................... 34
  - Asterisms ............................................................................ 36
Some Tips on Using Star Charts ........................................... 36
An Interstellar Perspective ......................................................... 38
Closer to Home: Atmospheric Phenomena .......................... 39
Our Celestial Backyard: The Solar System ...................... 42
   The Moon ........................................................................ 43
   The “Classical” Planets ..................................................... 45
But Wait – There’s More .......................................................... 54
Beyond the Backyard: Our Home Galaxy ............................. 58
Beyond Our Galaxy: The Great Big Universe Out There ...... 59
What’s Up? – A Closer Look .................................................. 61
   What’s Up? Setup............................................................ 62
Index .......................................................................... 63
Welcome to TheSkyX First Light Edition!

Most of you have never seen the sky. Not really. If you live in a city or suburb, a pale blue or grey dome looms overhead while the Sun is up, and a darkish brown curtain hangs down at night, with maybe a few sparks of light poking through here and there if the clouds haven’t gathered and the glare from buildings and cars and billboards isn’t overwhelming. The Sun and the Moon are unmistakable of course, but the spattering of stars you glimpse are probably strangers to you. Some of them might even be planets – for most people, it’s hard to tell the difference.

All of this is about to change. You have in your hands an extraordinary tool for revealing not just new worlds, but the entire universe. The night sky is an incredible wonderland of diverse and spectacular objects and phenomena. Some of these breathtaking sights are created by tiny particles that ply the fringes of our atmosphere. Others are immense, ancient structures, incomprehensibly far away.

*TheSkyX First Light Edition* will bring all of these amazing marvels and more to your desktop. It will help you learn the fundamentals of astronomy, the most ancient science, and teach you how to recognize just about everything in the real sky. Whether you’re looking up from the streets of a light-polluted city, or taking in the view from a remote, pitch-black mountaintop, *TheSkyX First Light Edition* will help you understand what you see and find what you’re looking for.
You’ll also enjoy experiences that are only possible through the magic of simulation and virtual-reality programming. Faster-than-light flights through the solar system, out-of-this-world views of the Earth and Moon, and the orbital tracks of hundreds of satellites are just some of the animations built into TheSkyX First Light Edition. Trips through space and time that were once possible only in the imagination will be vividly brought to life on your computer screen.

TheSkyX First Light Edition has something to offer everyone, from the absolute beginner to the most knowledgeable amateur astronomer. This User’s Guide will help you navigate the basic features and tools our unique program has to offer.

The sky is waiting for you. Let’s get started!

**Getting Started**

*TheSkyX First Light Edition* (hereafter referred to simply as *TheSkyX*) is available for either Mac or Windows operating systems.

**Macintosh**

*TheSkyX* for Mac can run on any Macintosh desktop or laptop computer running OS X 10.5 (Leopard) or later with a 1.25 GHz or faster G4 PowerPC processor, or a 2 GHz or faster Core Duo processor. You also need at least 512 MB RAM, 64 MB video RAM, and 450 MB of disk space, a mouse or other pointing device and a CD ROM drive.
Windows

*TheSkyX* for Windows can run on any desktop or laptop computer running Windows Vista or XP with a 1.5 GHz or faster Intel Pentium 4, Pentium M, Pentium D, or AMD K-8 (Athlon) or better processor. You also need at least 512 MB RAM, 64 MB video RAM, and 450 MB of disk space, a mouse or other pointing device and a CD ROM drive.

Updating Your Computer’s Video Driver

Before installing and using *TheSkyX*, we strongly recommend updating your computer’s video display driver.

Our latest applications use *OpenGL* to display accelerated graphics for smooth 2D and 3D animation and high-frame rates. For the best experience, make sure that your computer has the latest version of OpenGL installed.

Installing Mac Video Drivers

The latest version of OpenGL is included with the OS X software updates. Click the Apple icon, then click the *Software Update* command to make sure your Mac is up to date. That’s it.

Windows 7, Windows Vista and Window XP Video Drivers

For all 32- and 64-bit editions of Windows, the latest version of OpenGL is distributed as part of your computer’s video driver (the video driver is software that communicates with the video display hardware).
In order to obtain the latest version of OpenGL, you must install the latest video driver directly from the original equipment manufacturer (OEM) of your computer's video display adaptor.

Video driver software is updated very frequently, so chances are you don't have the latest driver installed on your computer right now.

To Properly Update the Windows Video Driver and OpenGL

First, determine the make and model of your computer’s video display adaptor. Both are listed in the Windows Device Manager (see Windows Help for details about accessing the Device Manager from XP, Vista and Windows 7). Do not use Windows Update feature to obtain latest video drivers and do not use the video driver that is supplied by Microsoft Windows as it does not include the latest version of OpenGL or the latest video driver for your video hardware.

Next, visit the Downloads page of the video driver manufacturer: AMD (ATI), Intel, NVIDIA or S3 Graphics. From there, download and install the latest video driver according to the video display hardware manufacturer’s instructions.

After installing the latest Windows video driver, you’re ready to install and run TheSkyX.
Installing TheSkyX First Light Edition

Macintosh

Like all Macintosh software, TheSkyX is easy to install. Insert the CD-ROM in the CD-ROM drive. TheSkyX icon should appear on your screen. Double click it. TheSkyX install icon should now appear. Double click that icon and follow the prompts. You’ll be asked for the all the usual stuff.

To launch TheSkyX, click Go > Applications from Finder, then double-click on TheSkyX First Light Edition icon.

Windows 7 and Windows Vista

To install TheSkyX under Windows 7 or Windows Vista:

1. Log on as an administrator. TheSkyX requires administrative privileges to be installed under Vista.
2. Insert the CD-ROM in the CD-ROM or DVD drive.
3. Click Start > Computer.
4. On the Computer window, select the removable storage device that holds TheSkyX media, and then click the Autoplay button (it’s located in the tool bar near the top of this window.)
5. On the AutoPlay window, click Run Readme.htm.
6. After carefully reading the instructions in the ReadMe file, click the Click Here to Begin Installation link. Follow the on-screen instructions to complete the installation.
Windows XP

To install *TheSkyX* under Windows XP:

1. Log on as an administrator. *TheSkyX* requires administrative privileges to be installed under XP.

2. Insert the CD-ROM in the CD-ROM or DVD drive and wait for the ReadMe file to appear in a browser window. If XP’s AutoRun is not active, then click **Start > My Computer**, right-click on the removable storage device that holds *TheSkyX* media and then click **Open**. Next, double-click the file named **ReadMe.htm** on *TheSkyX* media to proceed.

3. After carefully reading the instructions in the ReadMe file, click the **Click Here to Begin Installation** link. Follow the on-screen instructions to complete the installation.

To start *TheSkyX*, click **Start > All Programs > Software Bisque > TheSkyX First Light Edition > TheSkyX First Light Edition**.

We’ll discuss customizing *TheSkyX* for your geographic location in a moment…

About This User’s Guide

Not every function and feature of the *TheSkyX* is covered in this User’s Guide. The purpose of the Guide is to familiarize you with the basic organization and structure of our program, and to introduce those of you who are new to the subject of astronomy to some of its most important terms and
concepts. We also hope the Guide will stimulate you to become more interested in astronomy and space science, and excited to start learning about the extraordinary universe we live in.

More comprehensive information about *TheSkyX* can be found on our website:

http://www.bisque.com

**Removing TheSkyX First Light Edition**

If you must remove or uninstall *TheSkyX* from your computer please follow the procedure outlined below.

**Macintosh**

1. From Finder, click **Go > Applications** to open the Applications folder.
2. Drop *TheSkyX First Light Edition* application to the trash. Note that you must empty the trash before re-installing.

**Windows**

1. Log on as an administrator.
2. Click **Start > Control Panel > Uninstall a Program** (or double-click the **Add/Remove Programs** from XP).
3. Select *TheSkyX First Light Edition* from the list of installed programs, and click the **Uninstall** button (or click the **Remove** button under XP).

***
**Having a Look Around TheSkyX**

The star chart display is the heart and soul of TheSkyX. We call it the Sky Chart, to distinguish it from the real thing. To the left of the Sky Chart you’ll find the Command Center window with vertical tabs to access the most commonly used commands and options.

When TheSkyX is first launched, it attempts to automatically set your location and the date and time are read from your computer’s clock. You’ll also notice that if you are using TheSkyX during daytime, the sky it displays is blue. In a moment we’ll describe how to change that to a night view even during the day. Right now, let’s make sure that the program is set to display the Sky Chart from your location.

**Entering Your Location**

Home is where you hang your hat, and also where most of you probably watch the sky. You can enter your latitude and longitude, if you happen to know it, or choose the name of the city you live in, or the one closest to you, from the list in the Location dialog box:

1. Highlight the Input item in the Main Menu.
2. Select the first item, Location.

A dialog box appears displaying options for setting your location. From the List of Locations tab, if you live in the U.S., double-click on United States. A list of the major cities within your country will then appear. You can choose your city, or the one closest to where you live, by double-clicking on it. Alternatively, you can enter your latitude and
longitude or U.S. zip code from the Custom tab, or double-click your site on the Earth Map tab. When you’ve finished setting your location, close the dialog box.

To save this setting, click the **Save** command from the File menu.

***

**Tours**

Before we investigate the various menu and “button” commands arranged across the top of the screen, let’s explore some of the tours that have been created to help you appreciate several of the most common yet fascinating things you can see in the sky.

Notice the series of tabs running vertically on the right side of the Command Center window. Select the tab labeled **Tours**. A list of available tours is displayed:

- Analemma
- Angular size of Mars
- Coordinates - Equatorial
- Coordinates - Horizon
- Mercury evening visibility
- Mercury morning visibility
- Moon cycle - size and phase
- Motion of Barnard’s Star
- 24-Hour Motion of Saturn’s Moons
- Rotation and Phase of Mercury 2008
- Rotation and Phase of Venus 2008
• Saturn from Earth Over 10 Years
• Venus and Mercury Paths
• What Was That? (Iridium Flare Example)
• Winter Constellations

Go ahead and take one of the tours. Highlight one that sounds interesting, then click the Start button. Or, click the Run All button to watch them consecutively.

***

Photos from the Deep Sky

For more than a century astronomers have been taking pictures of the sky. In recent years, digital imaging sensors have replaced film to capture even more remarkable views of the moon and planets, as well as star clusters, nebulae, and galaxies. Relatively modest amateur telescopes, equipped with digital cameras, can capture images that rival the best photographs taken by professional observatories just a couple of decades ago.

TheSkyX has a veritable art gallery’s worth of fantastic space images you can look at anytime. Browsing these images will give you a taste of the extraordinarily diverse number of objects that populate the night sky.

Viewing Astronomical Photos

At the bottom of the list of vertical tabs on the Command Center, you’ll see a tab called Photos. Select it.
As you scroll through the list of objects, a small picture of each will be displayed below the list. Click the Show in Photo Viewer option to view them in a separate window.

***

**Your Sky Tonight**

This section of the User’s Guide is intended to help you explore the night sky from your location on any date, at any time. You’ll be able to answer the question: “When I head outside tonight at say, 9 p.m., what am I going to be able to see?” You’ll also learn how to plan ahead for special events, like meteor showers and lunar eclipses.

For a given location, what you can see in the sky on any given night depends on the date and time. The stars that are visible at 9 p.m. on a December night are very different from the ones you would see at 9 p.m. in June, for example. And the Moon and planets follow their own unique celestial paths – their positions, and their brightness, vary from month to month and year to year.

***

**What’s Up, Doc?**

*TheSkyX* includes a menu command that will display a select list of objects that will be visible in your night sky on the current date. You can set the parameters of this list to choose the kinds of objects you’re most interested in seeing.
Go to the **Tools** menu. The first item in the Tools menu is *What’s Up?* Select it.

A list of objects that will be visible from your location in tonight’s sky will be generated. When you highlight an item and click the adjacent **Information** button, various astronomical data regarding that object will be displayed.

Some of these objects, and the data displayed with them, may be unfamiliar to you. We’ll be describing most of the information in the *What’s Up?* command in more detail on page 61.

***

**The Calendar**

Mankind has been using calendars of one kind or another to mark the passage of time for thousands of years. The Calendar feature of our program charts the phases of the Moon, sunrise and sunset; you can even display and print a calendar for a single month or the entire year.

If you select the **Date & Time** tab on the Command Center window, a small calendar for the current month will be displayed. Here’s a great (if we do say so ourselves) feature: if you click on any date in the calendar, the Sky Chart automatically shifts to show you what the sky will look like on that date, for the current time. Notice also that the four major phases of the Moon are displayed in the calendar.
For a more detailed calendar, go to the **Tools** item in the Main Menu. Scroll down to **Calendar** and select it. A larger, printable calendar is displayed. Note that you can select various kinds of information to be included in the calendar by checking the appropriate boxes on the right-hand side of the window.

***

**Exploring the Sky Chart**

In this section of the User’s Guide we’ll focus on how to adjust and navigate the Sky Chart. The best way to learn our program is simply to use it. Feel free to play around with the various buttons and menu commands you see in the tool bars. *TheSkyX* won’t break, and it won’t bite you.

**Changing the Date and Time**

The clock built into your computer is constantly tracking the date and time. *TheSkyX* reads this and displays whatever is above your horizon right now, but it can also show you the sky for different times of day or night.

Select the **Date & Time** tab from the list of vertical tabs on the Command Center window. Below the calendar there is an item called **Set Specific Time**. Click it.

You’ll see a list of different “times” – not in hour and minute format, but in terms of astronomical events, for example, *sunset, moonrise, evening (end twilight)*, and so on. When you select one of these options, the Sky Chart shows you what the
sky will look at that time for the current date. Try several of the options and watch how the chart changes.

You can make time speed up and even go backwards. In the **Tools** menu, choose the item called **Time Skip**. Try one of the various options. The Sky Chart will continue moving backward or forward in time until you select **Stop**, or the **Use Computer’s Clock** option.

Finally, you can also enter a specific date and time by selecting the **Input** item from the Main Menu and choosing **Date & Time** (note there is also a shortcut key for this displayed within the menu – *TheSkyX* will always display shortcut keys in the menu whenever they are available).

***

**Direction – The Look Commands**

Our eyes can only see a small portion of the sky at a time. *TheSkyX* can show you the entire sky at once, but it’s often more useful to focus the display on one part of the sky at a time, to match what you can see in the real night sky with your unaided eyes.

Changing the direction of your view is accomplished with the **Look** commands. These can be found in the **Orientation** menu, but they are also available to you as buttons in the **Orientation** tool bar.

By default, the Sky Chart is displayed looking south. Click the **East** button in the **Orientation** tool bar. Note that the star field has changed; the
compass direction displayed at the bottom of the screen indicates E, for east. Experiment with the other compass direction buttons.

In addition to the compass direction buttons, a set of arrow buttons can be used to shift your viewing direction incrementally. Click the right arrow button. Notice how the view shifts slightly to the left (how far the Sky Chart shifts depends on your field of view, discussed below), just as if you were outside, looking at the real sky, and turning your head to the right. The left, right, up and down buttons function similarly (if your computer’s monitor is small, or the screen resolution is low, the entire toolbar may not fit on the screen, so you may need to click the “>>” symbol to display the up and down buttons), mimicking the movement of your head in the indicated directions.

You can also press and hold the CONTROL key then drag the mouse to adjust the position of the Sky Chart.

***

**Field of View**

You probably know that a circle can be divided into 360 degrees. Imagine a pie cut into six equal slices. The angle between the edges of a given slice is 360 \( / 6 = 60 \) degrees. Astronomers measure angles in degrees, and fractions of a degree: each degree is divided into sixty minutes, and each minute is divided into sixty seconds.

When you look at the sky, you can only see a portion of it. Imagine for a moment that the sky is
an immense spherical bowl above your head. When you look up at it, you’re seeing a slice of the sky that spans a particular angle.

Assuming you have normal peripheral vision, that angle is about sixty degrees – one slice of our imaginary pie. Another way of saying this is your *field of view* is sixty degrees. Some people can see a little more, and some a little less, but sixty degrees is about average for adults.

When you look at the sky with binoculars or a telescope, what you see is magnified – in effect, you bring the sky closer, making it easier to see detail and faint objects. The downside of magnification is that it always reduces your field of view, sometimes to just a fraction of a degree. Generally speaking, the greater the magnification, the smaller the field of view.

*TheSkyX* allows you to set the field of view to any angle, from 235 degrees to a fraction of a degree. This is very useful when you’re trying to understand how much of a particular constellation or star field might be visible in a pair of binoculars or a small telescope.

**Setting the Field of View**

The simplest way to change the field of view is to use the *Zoom In* and *Zoom Out* buttons. The current field of view is displayed next to these buttons. Click that button. A list of preset fields of view is displayed. Some of these correspond to the field of view of a typical pair of binoculars or amateur telescope.
The **Wide Field** option shows you the sky from horizon to horizon, 180 degrees. The **Naked Eye** option gives you a 100-degree field of view – a bit wider field than what you can actually see with your eyes, but we wouldn’t want you to miss anything.

You can also define a **zoom box** to zoom in on a particular area of the Sky Chart. Place your cursor on one corner of the area you want to zoom in on. Click and hold while you move your cursor to the opposite corner, then click anywhere inside the zoom box to enlarge it (you can click outside the zoom box to cancel this operation).

***

**Stellar Cartography**

Just as you would use a map to find your way around a city, state, or country, celestial maps or **star charts** are designed to help you find your way around the sky.

Use your mouse or track pad to move the arrow around the Sky Chart. You’ll notice that when the tip of the arrow touches an object, an information box describing that object is automatically displayed. The kind of information displayed depends in part on the nature of the object, but one thing that is always displayed is the location of the object. This is indicated by two different sets of coordinates.
Cosmic Coordinates

Maps of the Earth identify the location of landmarks with two numbers: latitude and longitude. Latitude is measured in degrees north or south of the equator, and longitude is measured in degrees east or west of the Prime Meridian.

A similar system is used for objects in the sky. The celestial equator divides the sky into two hemispheres, north and south. The celestial equivalent of longitude is called right ascension (TheSkyX uses the abbreviation RA) and the equivalent of latitude is called declination (dec). Right ascension is measured in hours, minutes, and seconds, from 0 to 24. This may seem odd at first, but there’s a very good reason for this peculiar convention: the Earth is rotating. It turns around once on its axis in 24 hours, but from our terrestrial perspective, it looks like the sky is rotating around the Earth every 24 hours. Right ascension is measured eastward from the constellation Aries, the Ram. Specifically, 0 hours RA, the First Point of Aries, is the position in the sky where the Sun crosses the celestial equator on the first day of spring.

Declination is measured in degrees north or south of the celestial equator. The celestial equator is 0 degrees declination. The north celestial pole is located at 90 degrees declination (Polaris, the North Star, has a declination very close to 90 degrees). The south celestial pole is at minus 90 degrees declination. You can also translate right ascension into degrees: a complete circle has 360 degrees;
dividing 360 by 24 gives 15, so every hour of right ascension is equal to 15 degrees.

Imagine a line running across the sky from due north to due south, splitting the sky in two. This line is called the *meridian*. When a celestial object crosses the meridian, it is also at its highest altitude in the sky. This is called the *transit time*. Generally speaking, the best time to observe a celestial object with a telescope is when it’s crossing the meridian.

This brings us to another way of identifying the location of an object in the sky: altitude and azimuth. Altitude is simply the number of degrees the object is above the horizon, from 0 (on the horizon) to 90 (directly overhead). Be careful not to confuse altitude with declination – they are not the same thing.

Azimuth indicates the compass direction of an object. Specifically, it is the number of degrees east of north that you need to turn to see the object. Due east, for example, is 90 degrees azimuth.

The problem with using altitude and azimuth for astronomical objects of course is that these numbers are constantly changing as the Earth rotates. *TheSkyX*, however, can calculate these numbers instantaneously, making it easier to know what direction to look when you’re outside in the dark, trying to find a particular object at a specific time.
Stars and Constellations

There are some 6,000 stars visible to the naked eye. Most of these stars can only be seen from locations far from the bright lights of a city or town. If you really want to see the stars, you either have to go to Hollywood or get out of Dodge.

Star Names

Some of the brighter stars have proper names, but most don’t – there are just too many to give each one a name. Instead, astronomers have devised a system that assigns names to stars based on their brightness and the name of the constellation they belong to. Following a centuries-long tradition, the brightest star in a constellation is designated by the first letter of the Greek alphabet, Alpha, followed by the genitive form of the name of its constellation. For example, the brightest star in the constellation Orion is called Alpha Orionis. It also has a proper name: Rigel. (We’ll talk more about constellations later. Right now we’re going to focus on individual stars.) When the letters run out, stars are identified by various alphanumeric designations.

A funny thing about Rigel: even though it’s the brightest star in Orion, its designation is Beta Orionis. Astronomers originally thought that Betelgeuse, another star in Orion, was a little bit brighter, but improvements in photometers in the 20th century revealed that Rigel is actually the brighter star (it’s possible that Betelgeuse might have been brighter in the past, when astronomers first began to designate stars with Greek letters).
Bright Stars and Dim Stars

Long before the invention of the telescope, astronomers also came up with a *numerical* system for classifying stars by their brightness. They decided that the brightest stars would be called First Magnitude. Those half as bright as First would be called Second Magnitude, then Third Magnitude, and so on down to Sixth Magnitude, which denotes the dimmest stars visible to the naked eye.

We use a modified form of this system today. The brightest star in the nighttime sky is called Sirius. It’s in the constellation Canis Major, the Big Dog, and it’s sometimes called the Dog Star. Its magnitude is *minus* 1.4, which we write as -1.4. This may seem a little confusing, but it isn’t that hard to understand. A couple of centuries ago, astronomers decided to make the magnitude scale more precise. They knew the Sun and Moon and some of the planets are brighter than the brightest stars, so these were given negative magnitudes. They also realized that a First Magnitude star is actually a bit more than twice as bright as a Second. In order to keep Sixth Magnitude as the faintest star visible to the naked eye, astronomers recalibrated the magnitude system to follow a *logarithmic* scale. Each stellar magnitude is about 2.5 times brighter than the next lower magnitude.

With a telescope, you can see stars much dimmer than Sixth Magnitude. *TheSkyX* database includes stars down to about 12th Magnitude.

On a clear, moonless night, people who live in cities or suburbs can rarely see stars dimmer than Third Magnitude. If you’re just starting to learn the
names of the brighter stars and constellations, you should set the magnitude filter in TheSkyX to Second or Third magnitude. That way, when you go out at night to compare what you see on your computer to what you can see in the real sky, you won’t be confused by a screen display that shows more stars than you can actually see from your location.

**Setting the Magnitude Limit**

This command tells TheSkyX to only display stars brighter than a selected magnitude.

1. Choose the **Chart Elements** tab from the Display menu, or click this tab on the Command Center Window.
2. Highlight the **Celestial Objects** text by clicking on it.
3. Click the Show Attributes button.
4. Near the middle of the Chart Elements tab you’ll see a button labeled **Magnitude Limits**. You can enter a value between 30.0 and -6.0, or change the magnitude using the slider.

**Note: you may need to stretch the Chart Elements window to access the slider.** You can adjust the size of a dialog box by moving the cursor to the edge of the box, then clicking and dragging it to the desired size. You can also move the box anywhere on the screen.

Notice as you move the slider how the number of stars on the Sky Chart changes to reflect the changing magnitude limit.
Other Chart Elements

Like land maps, star charts can be overlaid with a variety of lines and markings intended to highlight specific celestial features and help you find objects at specific coordinates.

The **Chart Elements** menu lets you display or hide various reference lines and symbols, but you should be aware that even though the cosmos mostly consists of empty space, a star chart can get very crowded very quickly. The celestial equator and lines of right ascension and declination can be added to the Sky Chart, for example. Experiment with this feature by clicking on the box next to a listed chart element to see how it affects the display.

***

A Star to Guide You: Polaris

For people living in the northern hemisphere, probably the most noteworthy star is Polaris, the North Star. It always stays in the same part of the sky, every night, 365 days a year. The reason for this is fairly simple: Polaris happens to be located almost directly above our North Pole. As the Earth rotates on its axis, other stars rise and set, but because Polaris is right above the pole, it always seems to stay in the same place.

How high Polaris is above your horizon is a direct way to find your latitude. If Polaris is 40 degrees above the local horizon, for example, you must be somewhere on the 40th latitude line. Philadelphia and Denver are both very close this latitude, as are Naples, Italy and Beijing, China. The stars you can see on any given date and (local) time are
essentially the same for all of these cities, and any other place along this line of latitude.

More than anything else, latitude determines what you can see in the sky. The North Star is not visible from the Southern Hemisphere, as are most of the stars and constellations near it. And there are all sorts of stars and constellations visible from the Southern Hemisphere that we never get to see in the North (the Moon and planets are visible from both hemispheres). TheSkyX can show you what the sky would look like from any place in either hemisphere.

***

**Double Stars**

A little more than half of all stars actually travel in pairs, orbiting each other in space. The American astronomer Henrietta Leavitt once quipped that three stars out of every two are double. Most of them appear as single stars to the naked eye. You need good binoculars or a small telescope to resolve them as double stars (there are also triple stars and groups consisting of four or even more stars).

Some double stars are true *binaries*, meaning they are gravitationally bound to each other and orbit a common point in space. Others only appear to be double because they happen to lie along the same line of sight from Earth, but are in fact many light years apart and not tied to each other by gravity.

One of the best-known double stars in the sky is called Mizar. It’s located in the handle of the Big Dipper.
Finding Mizar

Mizar is only visible from the Northern Hemisphere, and is easiest to find in the evening sky in Spring.

Select the Find tab from the vertical tabs on the Command Center window.

Type Mizar into the “Search For” box, then click the Find Now button. A double red “bull’s eye” will encircle the star in the Sky Chart.

The Big Dipper is one of the northern sky’s most recognizable asterisms (this term is described below). Being able to find it will help you find other nearby constellations, such as Cassiopeia. Once you’ve mastered these constellations, others will be easier to learn.

Another good thing about being able to find the Big Dipper: it will make it easy for you to find Polaris, and therefore true north. The two stars at the end of the cup of the dipper point to Polaris. Imagine a line connecting these two stars. Extend it in the direction the cup is pouring, about five times the distance between the two stars. The star you see at the end of that line is Polaris.

***

Variable Stars

Fortunately for us, and everything else that lives on Earth, the Sun radiates energy at a very nearly constant rate. But there are some stars that change in brightness dramatically over the course of a few months, and in some cases, just a few days or even
hours. These are called **variable stars**, and *TheSkyX* distinguishes them with a small red “v” to the lower left of the star.

The most notorious variable star is called Algol, a name derived from an Arabic word that means demon. Located in the constellation Perseus, its rhythmic dips in magnitude can easily be observed with the naked eye. Every 2.867 days, over the course of just a few hours, Algol falls from second magnitude (2.1) to third (3.4) and back. During these periodic dimmings, you can gauge its changing brightness by comparing it to other nearby stars. The evening sky in Autumn is the easiest time to find this fascinating object (it is only visible from the Northern Hemisphere). It may have been considered demonic in ancient times, but today we know this innocent star has a companion that orbits it every 2.867 days. Algol dims when that companion passes in front of it from our perspective. Such stars make up a special class called **eclipsing binaries**.

***

**Classifying Stars: The Stellar Zoo**

Stars differ not only in their brightness, but also in their size, surface temperature, and chemical composition. The one thing they have in common is that they are all spherical – although some spin so fast they tend to bulge in the middle!

All stars are basically immense balls of intensely hot gas that generate heat and light through a process called **nuclear fusion**. The temperature and
density in the core of a star are so great that lighter atoms smash into each with enough force to fuse into heavier atoms. In our own Sun, for example, atoms of hydrogen fuse to produce atoms of helium (this process involves several intermediate steps). The fusion process releases energy in the form of electromagnetic radiation – light.

By spreading starlight into a spectrum, astronomers can learn the temperature and chemical makeup of stars. After studying thousands of stars, it became clear that stars fall into various categories, or classes. Some are massive and bright, and have relatively short, tumultuous lives. Others are small and dim, and can shine steadily for tens of billions of years.

A letter and number system is used to define stars in terms of their most important physical characteristics, and these designations are displayed when you point to a star in the Sky Chart. A more complete discussion of spectral classes and the physics of stars can be found in any introductory astronomy text.

**Giants and Dwarfs**

When you see a bright star in the sky, there are two possibilities: the star is close by and relatively average in size, or it is far away and gigantic.

Rigel is the brightest star in the constellation Orion. It is nearly 800 light years away, but is the seventh brightest star in the sky. It is a whopper, with a diameter of about 100 million kilometers. The Sun, by comparison, is about 1.4 million kilometers across.
Astronomers distinguish between **apparent** magnitude and **absolute** magnitude. Apparent magnitude is how bright a star looks in the sky. Absolute magnitude refers to how bright a star would appear if it were located exactly 10 parsecs (32.6 light years) away. The apparent magnitude of Rigel is about 0.2, but its absolute magnitude is nearly -7.0.

***

**More About Constellations…**

The desire to find order in nature, even where none exists, seems to be built into the human brain. When you look up at the sky on a dark, clear night, the sheer number of stars can be overwhelming. Our distant ancestors must have been in awe of those countless lights randomly scattered across the sky like diamonds.

Because of our instinctive need to find order, cultures all across the globe have organized stars into distinctive patterns called **constellations**. These patterns are purely a product of the human imagination. Nature had nothing to do with creating them.

The constellations we recognize today have mostly come down to us from the ancient Greeks. Many of them represent mythological figures. Orion, for example, one of the most prominent constellations visible in northern wintertime, represents a heroic hunter who first appeared in one of the great epics of classical Greek literature, *The Odyssey*. Orion is accompanied by two hunting dogs that are also
immortalized in constellations: Canis Major and Canis Minor, the big and little dogs, respectively.

When you look at Orion, it isn’t hard to imagine the figure of a hunter with a raised arm wielding a club. You can see one classic representation of this figure by going to the Display menu and selecting Constellations & Asterisms Options. You can display line drawings, mythical figures, and constellation boundaries by checking the appropriate boxes. You can also use the slider labeled Transparency to adjust how bright these renderings appear.

For many other constellations, the connection between its array of stars and what it is supposed to represent is difficult to see, to say the least. They’re a little more like abstract art, intended to represent the idea of a thing rather than the thing itself.

Drawing lines between the stars of a given constellation provides a simple “stick figure” view of that constellation. When astronomers think about constellations at all, this is how they usually think of them. The more fanciful mythological drawings of constellations became popular in the early 17th century, especially in the gorgeous star charts engraved by the great German celestial cartographer Johann Bayer (Bayer is also credited with creating the system that designates stars with Greek letters and the genitive name of their constellations, as described previously).

When the constellations we recognize today were originally created, a number of stars were left over – that is, not all stars fit into the established patterns.
To avoid confusion, astronomers designated boundary lines between the constellations. Not unlike borders between countries, any star that falls within the borders of a given constellation is said to belong to it, whether it was included in the original depiction of that constellation or not.

**Asterisms**

There are familiar patterns of stars that don’t quite qualify as constellations. Astronomers call these patterns *asterisms*. The Big Dipper and the Pleiades (the Seven Sisters) are probably the two most familiar examples. In Japan, the Pleiades are called Subaru. You’ve probably seen them driving around your neighborhood.

***

**Some Tips on Using Star Charts**

Learning how to connect what you see on a star chart to what you see in the real sky takes some time. We’re going to show you a step-by-step process that will make it easier for you to find common stars and constellations. With a little patience and practice, you’ll soon become an expert.

First of all, when you go outside and look at the sky, you need to know what direction you’re facing. In particular, you need to know how to find true north. City streets often lie along north/south and east/west lines, but this isn’t always the case. If you aren’t sure which way is north at your viewing location, use a magnetic compass to find it.
When hundreds of stars are displayed on your chart, finding individual stars and constellations can be very challenging. But if you limit the number of stars in the chart to just a few dozen of the brightest stars, you’ll have a much easier time learning the sky.

Printing a chart to take with you when you go outside is also very helpful. TheSkyX can print any chart it displays. You can print an “all sky” chart, or select a particular part of the sky you’re interested in learning.

Choose File from the Main Menu.

At the bottom of the menu, you’ll see two items: Print and Print Setup (if you have more than one printer connected to your computer, Print Setup can be used to select the printer you’d like to use). Select Print.

An “Export Chart” dialog box appears on the screen. TheSkyX allows you to print to a file as well as directly to a printer. The Sky Chart as currently displayed on the screen will be printed. TheSkyX prints stars in black, leaving the sky white (if you have a color printer, stars brighter than 6th magnitude are printed as yellow circles). The size of the star is proportional to its magnitude. Non-stellar objects are printed using the symbols that appear in the Display > Map Like Sky Charts.

You can choose the orientation of the printout and other printing parameters by clicking the Page Setup button. When you’re ready to print, simply click the Print button in the “To Printer” box.
The best time to start learning the sky is a clear, cloudless night, when there is no moon or at most a crescent moon. Moonlight can interfere as much as city lights when it comes to seeing the stars, and if the moon is close to Full, you probably won’t be able to find any but the very brightest stars and planets. You also want to be in an open space, a place where there are no tall buildings, trees, or annoying artificial lights to interfere with your viewing. Make sure in particular that you have a clear view to the north.

When you get to your observing site, give your eyes at least a few minutes to adapt to the darkness. You’ll need a flashlight to read the chart of course, but you should use one that has a red filter. These can be bought at most stores that sell telescopes, or you can simply tape a piece of transparent red film over a standard flashlight. Using only red light will help preserve your night vision. If you take your computer outside with you, the Display > Show Night Vision Mode command will help preserve it, too.

***

**An Interstellar Perspective**

Our Sun is but one of billions of stars in the Milky Way galaxy. For centuries, astronomers have been charting the positions of other stars in our galaxy, and have accurately determined the distances to many thousands of them. This information allows us to step outside our solar system, in effect, and see what the Sun and other stars in our part of the
galaxy would look like from dozens of light years away.

*TheSkyX* includes a utility for showing this to you. Choose **Tools** from the Main Menu. Near the bottom of the pull down menu, you’ll see an item called **3D Stars**. Select it. A view of our Sun and its neighbor stars from outside our solar system is displayed. Using the slider near the bottom left of the screen, you can move from up to 2000 light years away from the Sun. The **Filter Stars by Distance from the Sun** slider will increase or decrease the number of stars in the display.

***

**Closer to Home: Atmospheric Phenomena**

As we mentioned earlier, some of the most interesting things we can see in the sky are happening right above our heads, in the upper atmosphere.

**Meteors and Fireballs**

You’ve probably seen a so-called shooting star (maybe you’ve even wished on one). A shooting star isn’t really a star at all, but a grain of space dust. When one of these particles hits our atmosphere, it’s traveling at tens of thousands of kilometers an hour. Friction makes it glow white hot, turning it into a *meteor*. It may seem surprising that a speck of dust at the edge of space could create a streak of light visible from the ground, but even the brightest meteor is rarely bigger than a pea.

The flying dust grains that cause meteors mostly come from the tails of *comets*. Several tons of this
material falls to Earth every single day. If you get away from the lights of the city and watch the sky on a moonless night for an hour or two, you’ll see at least a few meteors – maybe quite a few. They’re falling everywhere, all the time.

Once in a while something much larger than a speck of dust falls to Earth and creates a spectacular fireball. Fireballs can blaze across the sky with such intensity that they literally light up the landscape. They can range in size from a few centimeters to several meters. Bits and pieces of them sometimes survive the fiery descent through our atmosphere and crash into the ground. These fragments are called meteorites.

Meteorites are chunks of asteroids and they fall into three main categories, based on chemical composition. Iron meteorites are the most commonly found because they are very distinctive, consisting of ninety percent iron with a bit of nickel mixed in. They are extremely dense, and have magnetic properties.

Stony meteorites look more like common rocks. They are the most common form of meteorite but aren’t found as often as iron meteorites for two reasons: they look like ordinary, everyday Earth rocks, and they can’t be located using a metal detector.

The third class is the stony irons, which, as the name suggests, are a mixture of the iron and stony types.
A few people around the world make a good living hunting meteorites. A decent-sized specimen can be worth thousands of dollars to a museum or a private collector. A really big meteorite with an unusual composition can be worth millions. Something to think about next time you see a fireball…

**Meteor Showers**

The dust trails left by comets that have visited the inner solar system follow predictable orbits around the Sun. Several times a year Earth passes near one of these cosmic debris trains, resulting in a meteor shower. Halley’s comet, which has a 76-year orbit, is responsible for two annual meteor showers, the Eta Aquarids in early May, and the Orionid shower in mid-October.

Have you ever looked at a set of railroad tracks and noticed, as they stretch into the distance, how they seem to converge to a single point? A similar effect can be seen during a meteor shower. The debris “train” of the shower’s parent comet follows the tracks of an imaginary railroad. If you pay attention to the direction most of the meteors in a particular shower seem to be coming from, they all converge back to the same point in the sky – the “vanishing point” of the tracks of the debris train. This is called the *radiant*. TheSkyX plots the radiant for all annual meteor showers and estimates the date and time they are expected to peak.

To display meteor shower radiants, select the **Chart Elements** tab from Display menu. Within the list of elements, there is an item called **Reference Objects**.
Click it, and a new list of items is displayed. Check the box next to *Meteor Shower Radiants*.

The radiants for all meteor showers will now be displayed on the Sky Chart. If you move the cursor to the center of any radiant, details on that shower, including when it is expected to peak, will be displayed.

*The Northern (and Southern) Lights*

The Northern Lights, or *aurora borealis*, can be as stunning as any fireworks display. They appear as curtains of colorful, shifting light, suspended high up in the night sky. Unfortunately, they are generally only visible from far northern latitudes, and when they might occur is notoriously hard to predict.

Auroral displays are caused by charged particles from the solar wind striking the Earth’s upper atmosphere. Our planet’s magnetic field guides these particles toward the poles, which is why auroras are only visible from high northern and southern latitudes (the auroral light show is called the *aurora australis* in the southern hemisphere).

***

**Our Celestial Backyard: The Solar System**

Our Sun is one of countless stars in the universe. The planets that circle the Sun are its family, figuratively speaking, and it would be hard to deny that Earth is its favorite child. The planet we call home is located at just the right distance to be
neither too cold nor too hot for liquid water and life to flourish on its surface. But the rest of the Sun’s family – the solar system – is full of diverse and fascinating characters. Some of them may once have harbored some form of primitive life. These bodies are much, much closer than even the next nearest star, and so astronomers like to say they inhabit our celestial backyard.

Finding a planet in *TheSkyX* is simple. Simply go to the **Edit** menu and choose **Find**. Type the name of the planet in the **Search For** box. Information about the planet will be displayed. You can center the planet in the Sky Chart by clicking the **Center** button near the bottom of the screen. Note that this same procedure applies to every object in *TheSkyX*’s database. If you’re unsure of an object’s name or catalog number, click the Advanced button to view a comprehensive list of searchable objects.

**The Moon**

The most familiar object in the night sky is undoubtedly the Moon. It’s been Earth’s constant companion for more than four billion years. Scientists believe that the Moon was formed shortly after the birth of the solar system, when a molten planet about the size of Mars smashed into the Earth. That planet is no longer around, but much of the fallout from its impact settled into orbit around us and aggregated into the Moon.

The Moon is *tidally locked* to the Earth. Our gravitational pull, over millions of years, slowly put the brakes on the rotation of our satellite. Today the Moon makes one complete rotation for every single orbit it makes around the Earth. Because of this, the
same side of the Moon always faces the Earth. We had no way of seeing the far side of the Moon until spacecraft were sent there in the late 1950’s. Some people mistakenly call the far side of the Moon the dark side of the Moon. With all due respect to Pink Floyd, the Moon has no “dark” side. Over the course of a lunar day (about 29.5 Earth days) the far side of the Moon gets just as much sunlight as the side facing us.

As the Moon orbits the Earth, it goes through its familiar phases, from New to Full and back again. TheSkyX can tell you the phase the Moon on any date, at any time. It is automatically displayed on the star chart in its current phase and proper location whenever it is above the horizon. The orbit of the Moon is not a perfect circle, but an ellipse, meaning it has an oval shape (in fact, all orbits, from artificial satellites to planets to stars circling the centers of galaxies, are ellipses). TheSkyX will tell you the current distance between the Earth and Moon.

The Moon is one of the most interesting things to look at in binoculars or a telescope. Even a little magnification will reveal the larger lunar craters, and help you see the mare, the so-called lunar “seas,” which are really cooled lava basins. The Moon has no atmosphere, so liquid water cannot exist there. Our single natural satellite is dry as a bone, but there is some evidence that small amounts of water ice might reside in the permanently shadowed craters near the Moon’s poles.
To locate the Moon, on the Edit menu, click the Find command, enter the name “moon” in the Find text box, then click the Find Now button.

***

The “Classical” Planets

Not counting Earth, five planets are visible to the naked eye. It has been known since ancient times that the planets slowly change position relative to the stars, which appear to be fixed, never moving with respect to each other from year to year. In fact, the word planet derives from an ancient Greek term that means “wanderer.”

All planets in our solar system orbit the Sun (you probably know that the Sun is a star, not a planet). Their orbits lie more or less in the same plane, so as they circle the Sun, their paths are restricted to a narrow band in our sky, which is called the ecliptic. The constellations that lie in this plane received special attention from ancient astronomers. Collectively they are known as the Zodiac constellations.

The farther a planet is from the Sun, the longer it takes to complete a single orbit. Planets farther from the Sun therefore move more slowly through the Zodiac.

*TheSkyX* can locate any planet wherever it happens to be on a given night. Below we describe some general features of the planets, starting from the closest in, then moving out to the edge of the solar system.
Mercury

Mercury is the closest planet to the Sun. It takes only 88 days to travel around the Sun once. This is another way of saying that a year on Mercury is 88 days long.

Because Mercury is so close to the Sun, it can only be spotted shortly after sunset and shortly before sunrise, when it is near the “edge” of its orbit from our perspective. It is hard to see much surface detail on Mercury in even the most powerful telescope, but the Mariner 10 spacecraft made three “fly-bys” of Mercury in 1974 and 1975. Pictures from that spacecraft revealed Mercury strongly resembles our Moon, with a heavily cratered surface. It is comparable to our Moon in size, but much more dense. Being so close to the Sun, the surface of Mercury is very hot, as you would expect. The average daytime temperature there is above 400º C.

Venus

Commonly known as both the morning and the evening “star,” Venus is the brightest natural object in the sky after the Sun and Moon. Its beautiful radiance has dazzled mankind throughout history. Venus is so bright that, from a very dark location, it can cast shadows.

When astronomers first eyed Venus through telescopes, they discovered that the planet is perpetually enveloped in clouds. They never part, keeping the surface of the planet forever shielded from direct view. This fact led to a great deal of fevered speculation about what might be hidden
beneath those relentless clouds. Could Venus harbor steamy, tropical rainforests, inhabited by alien dinosaurs or even more exotic forms of life?

Much to the disappointment of science fiction writers, astronomers discovered in the early 1960’s that the surface temperature of this deceptively serene-looking planet is hot enough to melt lead. Venus is a hellish, uninhabitable desert. The reason for this is a runaway greenhouse effect. The Venusian atmosphere is almost entirely carbon dioxide (CO₂), a gas notorious for its effectiveness at trapping heat. The fact that high concentrations of CO₂ have raised the surface temperature of Venus so far above what we would otherwise expect is one reason some worry about rising CO₂ levels on our planet. If Venus had the same mix of nitrogen and oxygen in its atmosphere as we have in ours, it would almost certainly be a lovely place to spend your vacation.

When Galileo began to systematically observe Venus with his telescopes, he discovered it goes through phases like the Moon. This helped convince him that the Sun, not the Earth, is the center of motion in the solar system. Venus, like Mercury, is an “inner” planet, meaning that they lie closer to the Sun than we do. This is why these planets are visible only in the early evening or predawn skies – from our location in the solar system, they never appear to travel very far from the Sun.

**Earth**

Earth is the third planet from the Sun. Scientists sometimes refer to Earth as the Water Planet because more than 70 percent of our surface is
covered by liquid water, and water is essential for life. Our world is the only planet in the solar system that can support life as we know it.

A day is defined as the amount of time it takes for Earth to make one complete rotation on its axis. A year is defined as the time it takes Earth to make one complete orbit of the Sun. The length of a day and year are different on other planets because they rotate at different rates and have different orbits.

The axis about which our planet turns is tilted relative to the plane of our orbit. This is why we have seasons. In the summer, our northern hemisphere is tilted toward the Sun, so the days are longer, and sunlight strikes the Earth more directly, making the northern hemisphere warmer (the opposite is true in the southern hemisphere) than it is in winter. In the wintertime, our northern hemisphere is tilted away from the Sun. The days are thus shorter and colder (again, the opposite is true in the southern hemisphere).

A solstice occurs when our axis is tilted directly toward or away from the Sun. The winter solstice is the shortest day of the year, and the summer solstice is the longest (depending on your latitude, this may or may not correspond to the times of earliest sunrise and latest sunset – the explanation is a little more complicated than what we’re prepared to discuss here).

An equinox occurs when the center of the Sun is directly above the Earth’s equator. There are two of these each year, one in spring (the vernal equinox) and one in fall (the autumnal equinox). Equinox is
derived from Latin and means “equal night.” During an equinox, night and day are both just about 12 hours long.

Like all planets, the orbit of the Earth is not perfectly circular, but slightly elliptical. The Earth is about a million kilometers closer to the Sun in December than June.

**Mars**

The next planet out from the Sun is Mars. It is about half the size of our planet and takes a little more than two years to go around the Sun once. Mars is very similar to Earth in two important ways. Its day is just over 24 hours long, and its axis of spin is tilted about 23 degrees, almost exactly the same tilt as Earth. This means that Mars has seasons, just like we do. But they last twice as long, since a Mars’ year is about twice as long as one of ours (687 Earth days, to be more precise).

Like Venus, the atmosphere of Mars is almost entirely CO₂. Unfortunately it is an extremely thin atmosphere, about 1/100th the pressure of our atmosphere at the equivalent of Martian sea level. During the day, the surface temperature of Mars near the equator can rise above freezing, but that same night it will drop well below –100º C. A little more greenhouse effect on Mars would be a welcome thing. As it is, the air on Mars is too thin to support liquid water on its surface, another blow to all those science fiction writers who imagined alien beings and ancient civilizations on Mars.

Still, Mars is the only other planet in our solar system whose surface is directly accessible to
astronauts. Even though liquid water can’t exist on Mars today, there is lots of geological evidence to suggest that in the distant past, the atmosphere of Mars was much thicker, and water flowed there freely. This gives scientists hope that Mars may have once harbored simple forms of life. If life did thrive there in the distant past, it may still survive today, perhaps in small “oases” deep underground, where organisms would be protected from the harsh conditions on the surface.

The best time to look at Mars in a telescope is during an opposition. About every 26 months, Mars and Earth line up on the same side of the Sun. This is when Mars is at its brightest and closest, and therefore appears at its best in a telescope. TheSkyX can calculate the dates of future oppositions and even tell you how large, in arc seconds, the disk of Mars will appear in an Earth-bound telescope.

As Mars approaches opposition, it briefly exhibits retrograde motion. This is a fancy way of saying that Mars looks like it turns around and moves backward in the sky for several days. This is simply a trick of perspective. As our two planets orbit the Sun, Earth catches up to and passes Mars. When we pass, Mars appears to move backward with respect to the far more distant stars.

Looking at Mars through a telescope, the first thing an observer usually notices on the disk of the planet are the albedo features. These are bright and dark markings that mostly correspond to variations in the coarseness of Martian surface dust. They were first systematically charted and named by the Italian astronomer Giovanni Schiaparelli in the 19th
century. He mistakenly believed that the dark features were seas and lakes, and he used the Latin terms *mare* and *lacus* accordingly. Today we know there is no surface water on Mars, but like Earth, the Red Planet does have polar caps. Unlike our polar ice, they are made not just of frozen water but carbon dioxide or “dry ice” as well. During an opposition, you can usually glimpse either the northern or southern cap in a small telescope.

There is a huge difference between seeing Mars in a telescope and looking at images of Mars taken by orbiting spacecraft. Beginning with the Mariner 4 fly-by in 1965, American, Russian, and European spacecraft have revealed Mars to be a world of geological wonders. Huge craters, towering volcanoes, and immense systems of canyons mark and etch its surface.

Mars is orbited by two small moons, named Phobos and Deimos (ancient Greek words for fear and terror, respectively). They are much smaller than our Moon, irregularly shaped, and difficult to see in most amateur telescopes. Some scientists believe these moons are actually wayward asteroids.

**The Asteroid Belt**

A ring of interplanetary debris circles the Sun between the orbits of Mars and Jupiter. These rocky fragments are thought to be remnants from the original disk of material that formed the planets. The gravity of Jupiter prevented these bodies from aggregating into a planet in their own right. There are literally millions of asteroids, but collectively their mass is only about 1/10 the mass of our Moon.
Ceres is the largest asteroid, and the first to be discovered back on New Year’s Day in 1801.

**Jupiter**

Jupiter is the king of the planets. Ten times wider than Earth, it has more mass than all of the other planets in our solar system combined. Nearly a billion kilometers from the Sun, it takes twelve years to complete a single orbit.

Jupiter has a family of dozens of moons of various sizes and shapes, forming, in effect, a “mini” solar system. At last count, astronomers have charted over 60 moons orbiting this giant world. Many of these bodies are small as a typical asteroid (some of them might even be asteroids that were captured by Jupiter, caught like flies in its gravitational web).

Jupiter is attended by four large moons comparable in size to our own Moon. Because they were discovered by Galileo when he first turned his telescope on Jupiter in 1609, we call them the *Galilean satellites*.

*TheSkyX* includes telescope and spacecraft images of Jupiter, and can plot the orbits of its Galilean satellites. This is a particularly useful feature if you have a telescope. The moons shift position night to night as they orbit Jupiter, and you can track these motions with a modest telescope, or even a good pair of binoculars. Also, when a Galilean moon passes in front of Jupiter, it casts a shadow on the disk of the planet that can be observed in small telescopes. These *shadow transits* are fascinating to observe, and *TheSkyX* can tell you when they will occur. It also provides timings for another
interesting phenomenon involving Jupiter’s moons, an \textit{occlusion}. These occur when one of the moons enters the giant planet’s shadow and passes behind it. Interesting Historical Note: by timing the occultations of the Jovian moon Io, the astronomer Ole Romer was able to make a rough estimate of the speed of light way back in 1676.

\textbf{Saturn}

Author’s comment: \textit{I’ll never forget the first time I saw Saturn through a telescope. I was 11 years old. The telescope was small enough to fit in a lunchbox, but it was made by an extraordinary man named Max Bray, and was more than a match for Saturn. In the eyepiece, I saw a small white disk nestled inside a perfect set of white rings. It took my breath away. Everyone I know who has ever seen Saturn in a telescope remembers it. The most fun I’ve ever had in over three decades of being involved in astronomy is showing someone Saturn in a telescope for the first time. The planet is best known of course for its extraordinary rings.}

Saturn takes nearly 30 years to complete one orbit around the Sun. During this period, our view of the rings is slowly changing. Sometimes they are spread relatively wide and are easy to see, but about every 15 years they line up edge-on to our view. These “ring plane crossings” last a few days or so, and during this time all that can be seen of the rings is a dark, thin line crossing the disk of the planet.

Like Jupiter, Saturn is attended by numerous moons of various shapes and sizes. Titan, the largest, has a mostly–nitrogen atmosphere about one-and-a-half times thicker than the Earth’s.
But Wait – There’s More

Saturn is the farthest planet that was known to man in ancient times. The invention of the telescope revealed innumerable new worlds never before seen by human eyes, including previously unknown planets in our own solar system.

Uranus

The seventh planet out from the Sun, Uranus is the first planet discovered by telescope. The astronomer William Herschel is credited with recognizing it as a planet over two hundred years ago, in 1781 (other astronomers had seen it, but mistook it for a star – Herschel initially thought it was a comet). Like Jupiter and Saturn, it is a giant, much larger than Earth, and its atmosphere is mostly made of hydrogen and helium. But there are also significant amounts of water, ammonia, and methane ice in this frigid world, and so astronomers refer to it as an Ice Giant.

At a distance of almost 3 billion kilometers, Uranus takes 84 years to make a complete trip around the Sun. Its axis of rotation is tilted 98 degrees to the plane of its orbit, as if the planet had been flipped on its side. Like all of the giant planets, Uranus has an extensive family of moons, at least 27. They are named after characters taken from the works of Shakespeare and Alexander Pope. The largest, Titania, is about half the size of Earth’s Moon.

On a dark, moonless night, Uranus is just barely visible to the naked eye – if you have very sharp vision and know exactly where to look. TheSkyX,
of course, can tell you where to find it. Uranus is relatively easy to find in a good pair of binoculars.

**Neptune**

The next planet out, Neptune is similar in size and composition to Uranus. It is also considered an Ice Giant. The existence of Neptune was predicted by mathematical analysis of the orbit of Uranus. Deviations in the predicted orbit of Uranus led astronomers to believe that some other large body farther out in the solar system periodically tugs at Uranus. This theory was confirmed when Neptune was discovered close to its predicted position.

In a telescope, Neptune appears cool blue in color. It was first spotted by none other than Galileo, when it happened to be near Jupiter in the sky, but Galileo assumed that this faint blue object was a star, not a planet, and so he is not credited with its discovery.

It takes Neptune over 184 years to make a single orbit of the Sun. Discovered in 1846, it has yet to make a single orbit since it was first recognized as a planet. It lies some 4.5 billion kilometers from the Sun, and is attended by 13 diverse moons. The largest, Triton, is 2,700 kilometers in diameter, just a little smaller than our own Moon. Triton orbits Neptune in a *retrograde orbit*, which means that it travels backwards relative to the direction of rotation of Neptune itself. This suggests that Triton did not form with Neptune, but came into being somewhere farther out in the solar system and was later captured by Neptune’s gravity.
**Pluto and the Ice Dwarfs**

We all used to be taught that there are nine planets in the solar system. That is no longer the case. Pluto has been demoted. Today it is not considered a full-fledged planet, but an *ice dwarf*, one of perhaps hundreds of such objects that inhabit the outer reaches of the solar system.

Many people, including a lot of astronomers, are unhappy that Pluto has lost its status as a planet. Controversy is still raging over the decision to reclassify it. If you’re wondering who gets to decide whether or not Pluto is a planet, the authority rests on a group called the International Astronomical Union (IAU). Founded in 1919, the IAU has some 10,000 members, all professional astronomers. Its main purpose is to promote and protect the science of astronomy internationally, but it also has sole authority for classifying and naming astronomical objects. Despite some groups that claim otherwise, you cannot have a star named after yourself or a loved one without going through the IAU.

During their August, 2006 meeting, the IAU membership voted on a new, more rigorous definition of a planet that had been developed by one of its working groups. This new and improved classification scheme included the category “dwarf planets” to cover objects in our solar system that had recently been discovered beyond the orbit of Pluto. Unfortunately for Pluto fans, it perfectly fits the new category, hence the demotion.
Land of the Comets: The Kuiper Belt and the Oort Cloud

One of the most beautiful things you’ll ever see in the sky is a bright comet. Comets are refugees from the outer fringes of the solar system. Mixtures of ice and dust, the astronomer Fred Whipple famously described comets as “dirty snowballs.”

Astronomers believe that most comets spend their lives in either the Kuiper Belt or the Oort Cloud. Named for the astronomers who first theorized their existence, these regions of space, far beyond the orbit of Pluto, are thought to be repositories of matter left over from the formation of the solar system.

A gravitational nudge from a nearby star or a passing cloud of interstellar dust can send an object from this region careening into the inner solar system. When a comet gets close to the Sun, its ice begins to sublimate. The escaping gas and dust form the coma and tail that give comets their distinctive appearance.

Most comets are unexpected strangers to our part of the solar system, but some have settled into predictable, short-term orbits. Halley’s Comet is probably the most famous example. TheSkyX charts the orbits of several periodic comets. Most of them can only be seen on rare occasions with a telescope, but you never know when a new comet will be discovered and grace our sky in spectacular fashion, as comets Hyakutake and Hale-Bopp did in the late 1990’s.

***
Beyond the Backyard: Our Home Galaxy

Our Sun is but one member of a huge assemblage of hundreds of billions of stars that comprise our home galaxy, the Milky Way. Our galaxy is also peppered with vast, colorful clouds of gas and dust, called nebulae, and other exotic objects.

The invention of the telescope revealed that there is much more in the night sky than stars and planets. In the 18th century, the French astronomer Charles Messier began to catalog some of these mysterious objects to make sure he didn’t mistake them for new comets. The Messier Catalog is still in use today. It includes star clusters, and various kinds of nebulae and galaxies. These so-called “deep sky” objects are favorite viewing targets of amateur astronomers.

There are literally millions of objects in the sky that astronomers want to keep track of. Various catalogs have been developed for this purpose. TheSkyX includes several of them in order to chart these objects on the Sky Chart.

The Milky Way

The ancient Greeks believed that the Milky Way was exactly that: spilled milk. History failed to record whether anyone cried over it. It wasn’t until Galileo invented the astronomical telescope that the true nature of the Milky Way was revealed: millions of stars too distant to be resolved by the naked eye. We now know that the stars of our particular galaxy form an immense pinwheel shape, with several spiral arms extending out from its center. When
you look at the Milky Way, you’re looking at a section of one of these spiral arms (galaxies come in a variety of shapes and sizes, from spherical to irregular – more on this later).

An unfortunate fact of modern life is that the Milky Way is too faint to be seen from within cities and most of their suburbs. You need to be far from city lights and any other source of light pollution to appreciate how extraordinarily beautiful it is. TheSkyX can display the Milky Way at various levels of brightness, simulating what you might see from the outskirts of a small town or an isolated mountain peak. Astronomers have come up with the very cool-sounding term *isophote* to describe regions of equal brightness in the Milky Way.

***

**Beyond Our Galaxy: The Great Big Universe Out There**

About a hundred years ago astronomers believed that our galaxy, the Milky Way, contained pretty much everything in the universe. But as telescopes became larger and more powerful, it became clear that there are other galaxies beyond the Milky Way – lots of them, in fact. According to the latest estimates, there are some fifty to one hundred billion galaxies in our universe comparable in size to the Milky Way.

Our galaxy is also surrounded by a halo of some hundred and fifty star clusters. These clusters contain hundreds of thousands to millions of stars arranged in relatively compact, spherical shapes. These *globular clusters* are made up mostly of
ancient stars, some of them over ten billion years old.

Just as some planets have moons, the Milky Way and many other galaxies are orbited by smaller “satellite” galaxies. The Milky Way has at least two. They were originally described by Persian astronomers, but today we call them the Magellanic Clouds in honor of Ferdinand Magellan, a 16th century European explorer who observed and charted them on one of his epic voyages into the Southern Hemisphere. Our galactic companions are most easily seen from that hemisphere, although at certain times of year they can be glimpsed from very low Northern latitudes. They are beautiful objects, and to the naked eye look like small shreds of the Milky Way. Even though they lie only 20 degrees apart in the sky, they are separated by 75,000 light years in space. With a telescope you can resolve some of their stars, and also see nebulae and star clusters that reside within them.

The Milky Way is just one of billions of galaxies that populate the Universe. Besides the Magellanic Clouds, only one of these other galaxies is visible to the naked eye. It’s called the Andromeda Galaxy because it lies within the boundaries of that constellation. Every other galaxy requires a good pair of binoculars or a telescope to see.

TheSkyX’s database includes thousands of galaxies within reach of amateur telescopes. They can be displayed in the Non-stellar Objects section of the Chart Elements menu.
Galaxies of various shapes and sizes exist right out to the edge of observable space. We live in a truly extraordinary universe. We hope the TheSkyX will enrich and expand your appreciation of it.

***

**What’s Up? – A Closer Look**

With all the objects “up there” which ones are best to look at tonight? The Tools > What’s Up Setup > What’s Up button makes answering this question a bit easier.

By default, each time the What’s Up button is clicked, the Observing List window presents a list of the most interesting objects that are visible to the naked eye for the current time.

Select an object in the list to view observing notes on the object. To view detailed information about the object, click the Find window on the Display menu. To view its photo (if there is one available) or an H/R (Hertzsprung-Russell) Diagram for stars in the Hipparco/Tycho catalog, click the Show Photo Viewer in the Photos window.

The selected object can be centered on the Sky Chart by selecting the Center and Frame command from the Show on Sky Chart popup menu.

Here’s a neat feature: Select the first item in the What’s Up list. Next, on the Show on Sky Chart pop-up menu, select Naked Eye View, then use the down arrows on the keyboard to scroll through the list. Notice that the Sky Chart is updated to show a
green laser pointer indicating position of each object.

**What’s Up? Setup**

Use the *Tools > What’s Up Setup* command to configure your viewing time (current time, morning, evening or midnight) and what optical aid you’ll be using (naked eye, binoculars or small telescope). The *Interesting Objects (Top Ten)* option finds what the authors believe are the best objects or events to view.

You can also filter which types of objects you want to view. Once you’re done, click the What’s Up? button to update the report.

***
Index

3D stars, 39
absolute magnitude, 34
albedo, 50
altitude, 25
analemma, 15
apparent magnitude, 34
Asteriod Belt, 51
asteroids, 40
asterisms, 36
aurora australis, 42
aurora borealis, 42
azimuth, 25
calendar, 18
celestial equator, 24
comets, 39, 57
Command Center, 14
constellations, 34
date & time, 20
date and time, 19
declination, 24
Deimos, 51
Disclaimers, 3
double star
  binary, 30
dwarf planets, 56
Earth, 47
eclipsing binaries, 32
ecliptic, 45
equinox, 48
export
  star charts, 37
field of view, 21, 22
field width, 22
find
  objects, 43
  planets, 43
fireball, 40
galaxies, 58
globular clusters, 59
Hipparco/Tycho stellar
catalog, 61
ice dwarfs, 56
Ice Giant, 54
images
  celestial objects, 16
information
  about an object, 18
International Astronomical
  Union (IAU), 56
isophote, 59
Jupiter, 52
location, 14
location on Earth, 14
logarithmic scale, 27
Magellanic Clouds, 60
magnitude, 27
  absolute, 34
  apparent, 34
  filtering by, 39
mare, 44
Mars, 49
Mercury, 46
meridian, 25
meteor, 39
radiant, 41
showers, 41
meteorites, 40
   iron, 40
   stony, 40
Milky Way galaxy, 38, 58, 60
minor planets, 40
Moon, 43
naked eye, 23
nebulas, 58
Neptune, 55
night vision, 38
nuclear fusion, 32
Oort Cloud, 57
orientation commands, 20
Phobos, 51
Photo Viewer, 17
photographs, 16
photos, 16
pictures, 16
planets, 45
Pluto, 56
printing charts, 37
radiants
   meteors showers, 42
red screen, 38
retrograde motion, 50
right ascension, 24
Saturn, 53
save command, 15
seasons, 48
sky chart, 14
small solar system bodies
   comets, 57
   pluto, 56
solstice, 48
spectral class, 33
star names, 26
sunset, 19
tours, 15
transit time, 25
twilight, 19
uninstall, 13
Uranus, 54
variable stars, 32
Venus, 46
What’s Up Tonight?, 17
Zodiac, 45
zoom
   in, 22
   out, 22
zoom box, 23